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Background/Introduction 
Seneca College embraces the requirements of the Accessibility 
for Ontarians with Disabilities Act (AODA) and is committed to 
expanding access and support to all students, employees and 
visitors with disabilities, by having as its goal a barrier-free 
learning and working environment to enable academic and 
employment success. 

In 2005, Ontario introduced its first legislation, designed to 
create a province of inclusion for people with disabilities - the 
Accessibility for Ontarians with Disabilities Act (AODA). The 
AODA sets out the structure by which we can make Ontario 
accessible to all people by 2025.  

The purpose of the AODA is to develop, implement and enforce 
accessibility standards so businesses and organizations that 
provide goods and services will have rules to meet to identify, 
remove and prevent barriers to accessibility.  The Accessibility 
standards will apply to five key areas of daily living.  Four 
standards have already been made into law: 

• Customer Service 

• Transportation 

• Information and Communication 

• Employment  

The fifth standard – Built Environment – is being developed. 

The standards apply to Seneca College and as such we are 
obligated to meet the requirements of these standards.  

To find out about what is a ‘disability’, what is a ‘barrier’, and 
what an ‘accessibility standard’ is, and much more – go to the 
Accessibility for Ontarians with Disabilities Act website (Ministry 
and Community and Social Services). 

Seneca has provided a number of resources to assist faculty 
and staff in developing accessible materials.  These resources 
are available through Seneca Human Resources at 
https://inside.senecac.on.ca/hr/aoda/ 

Seneca College Accessibility 
Seneca College has processes and offices established to 
provide services to persons with disabilities. The office of 
Diversity and Equity within the Human Resources department 
works with other College departments to develop and implement 
accessibility, diversity and equity initiatives, as well as 
adherence to the Accessibility for Ontarians with Disability Act, 
ensuring that the College provides a respectful, accessible, safe 
and inclusive environment by supporting and communicating to 
people of all abilities.  The Student Conduct Office is the 
College’s resolution centre for student related issues and 
provides students with a respectful, impartial and safe 
environment where complaints can be heard.  Student Health 
and Accessibility Department is a student service which 
provides academic accommodations and support to students of 
all abilities who have a documented learning, physical, sensory, 
mental health disability or medical condition.  

http://www.mcss.gov.on.ca/en/mcss/programs/accessibility/index.aspx
https://inside.senecac.on.ca/hr/aoda/
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Legal and Policy Background  
There are three "guiding principles" for creating accessible 
documents: 

1. The Ontario Human Rights Code  
2. Reasonable and Appropriate Accommodation 
3. Accessibility for Ontarians with Disabilities Act 

Ontario Human Rights Code 
The Ontario Human Rights Code is a provincial law that gives 
everybody equal rights and opportunities without discrimination 
in specific social areas such as jobs, housing, services, facilities, 
and contracts or agreements.  The “Code’s” goal is to prevent 
discrimination and harassment because of race, sex, disability, 
and age, to name a few of the fifteen grounds. All other Ontario 
laws must agree with the “Code”: 
http://www.ohrc.on.ca/en/learning/ohrc-elearning-your-
elearning-source-human-rights 

All service providers must provide equal treatment to all persons 
without discrimination because of a disability (includes 
temporary and permanent disabilities, being in receipt of 
Workers Safety and Insurance Benefits in the past or at present, 
learning disabilities, visible, invisible and perceived disabilities).  
All reasonable measures must be taken by service providers to 
accommodate a person with a disability, short of “undue 
hardship” (subsection 24(2)). The Code defines “disability” 
(section 10(1)) broadly, to include physical disabilities, 
infirmities, malformations, disfigurement or illness, as well as 

mental impairment, developmental or learning disability, 
language dysfunction or mental disorders.1 

Reasonable and Appropriate 
Accommodations  
What are “reasonable and appropriate accommodations” and 
what does “short of undue hardship” mean in the academic 
context? What constitutes reasonable measures will vary 
depending on the circumstances.  In other words, different types 
of disabilities require different accommodations and each 
student must be assessed on an individual basis in the context 
of the particular course and its academic requirements.  

Accessibility for Ontarians with Disabilities 
Act 
The Accessibility for Ontarians with Disabilities Act1, 2005 
(AODA) became law on June 13, 2005. Under this landmark 
legislation, the government of Ontario developed mandatory 
accessibility standards that will identify, remove and prevent 
barriers for people with disabilities in key areas of daily living.  

Five key areas have been identified by the Legislation: 

1. Accessibility Standard for Customer Service. The 
standard states what businesses and other organizations 
in Ontario must do to provide good customer service in 
ways that are accessible to people with disabilities. 

                                            

 

http://www.ohrc.on.ca/en/ontario-human-rights-code
http://www.ohrc.on.ca/en/learning/key-concepts/code-has-primacy
http://www.ohrc.on.ca/en/learning/key-concepts/code-has-primacy
http://www.ohrc.on.ca/en/learning/ohrc-elearning-your-elearning-source-human-rights
http://www.ohrc.on.ca/en/learning/ohrc-elearning-your-elearning-source-human-rights
http://www.mcss.gov.on.ca/en/mcss/programs/accessibility/
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2. Accessibility Standard for Transportation. This 
standard is the only one that is sector specific, that is, it 
relates specifically to modes of transportation that will 
make it easier for everyone to travel in Ontario.  Come 
under the jurisdiction of provincial and municipal 
governments. 

3. Accessibility Standard for Employment. The goal is to 
help employers create equal employment opportunities 
for people with disabilities.  To help to make accessibility 
a regular part of finding, hiring and supporting employees 
with disabilities. 

• Accessibility Standard for Information and 
Communication (which includes digital/course 
content). Outlines how businesses and organizations are 
required to create, provide and receive information and 
communications in ways that are accessible for people 
with disabilities. Education and training institutions must 
provide educational and training resources and materials 
in accessible formats upon request; provide educators 
with accessibility awareness training related to accessible 
program or course delivery. 

4. Accessibility Standard for Built Environment. The 
goal is to break down barriers in buildings and other 
structures for people with disabilities by proposing 
accessibility requirements.  

Plain Language Definition and 
Guidelines 
Plain Language is accessible for many persons with disabilities.  
When producing a document you may want to consider 
incorporating some of the basic principles of plain language or 
plain English. 

There are many definitions for Plain English or what is 
sometimes referred to as Plain Language.  The goal is always to 
use language in a way that is user friendly, clear, direct and 
natural. 

As a starting point, the writer should:  

• Always consider who the target audience is.   
• Make it your goal to convey the ideas with the greatest 

possible clarity.   
• Do not make the document sound formal and omit 

unnecessary details. 
• Scale back the information to what your reader needs to 

know and use examples as needed to help explain the 
text.  

• Remember whenever possible to write in active voice.  
The active voice emphasizes the doer of an action, and it 
is usually briefer and clearer.   



 LEADERSHIP  
& EMPLOYEE 
DEVELOPMENT 

 

Guide to Creating Accessible Documents-2012 Page 7 of 30 

Design  
Consider these design elements: hierarchy of information, 
typography, layout, graphics and color. 

A typical hierarchy may include, document title, section 
headings, subsection headings, paragraph headings and 
general text. 

• Divide your information into short sections. 
• Make a table of contents for long documents. 
• Use lots of headings. 
• Structure your writing by putting the main message first. 
• Typefaces (fonts) come in two varieties: serif and sans 

serif. 
• Minimize the mixing of typefaces as not all typefaces 

work well together.  As a general rule, do not use more 
than two typefaces in a document. 

• Use at least 10 to 12 point type for text. 
• Use a maximum of 70 characters in a line.  Any longer 

and readers will lose their place when they read from line 
to line. 

• Columns should contain a maximum of 40 characters.  
Remember to use ample white space between columns. 

• Use techniques such as boldface, bullet dots – but do not 
over use. 

• Avoid using all-capital letters.   
• Graphics such as diagrams, tables or charts should be 

used in explaining text.  Make sure they have informative 
headings and try to place them on one page.  

• Keep the design of any graphic simple and drawn to 
scale.   

• Be consistent when grouping graphics. 
• Use white space in margins, around headings and 

between sections. 
• Justifying the right margins decreases readability. The 

easiest text to read is left justified, ragged right text.  This 
document is set left justified, ragged right. 

• The majority of the document should be produced in 
black and white.  Colour elements in your document 
should not overwhelm or distract the legibility of your text. 

Organizing the document 
• Use descriptive headers and sub-headers to break 

documents up into manageable pieces. 
• Make sure your headings tell the reader what the 

upcoming sections will cover.  Headings like “general” or 
“background” are not very helpful. 

• Use short sections or subdivide the longer ones. 
• Always group related material.  This helps you eliminate 

repetitious information. 
• Use vertical lists to identify the important material. 
• Order the information.  Put the more important 

information before the less important and the general 
before the specific. 

• Use lots of headings. 
• Minimize cross-references. 
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Sentences 
• It is best to use short and medium-length sentences with 

an average length of about 20 words. 
• Try and keep paragraphs under 10 or 12 lines. 
• Whenever possible put the subject and verb near the 

beginning. 
• Use concrete, familiar words and no surplus of words. 
• Use Active voice with strong verbs. 
• Keep the subject near the verb, and the verb near the 

object. 
• Use examples to make complex information more 

understandable. 
• User parallel structure for parallel ideas.  State related 

ideas in similar grammatical form.   
• Don’t use unnecessary qualifiers or double negatives. 
• Avoid redundancies. 

Words 
• Use simple, direct words.   
• Omit needless words. 
• Avoid legal jargon. 
• Explain technical terms that you cannot avoid using. 
• Never use “shall”.  This is an ambiguous word.   
• Use the word “must”.  It is the clearest way to convey to 

the reader they have to do something. 
• Be consistent with the terms you use to mean the same 

thing. 
• Use personal pronouns.  Helps readers relate better to 

documents. Personal pronouns clarify what applies to 
your reader and what applies to you.  

• Find nouns and try to make it the main verb of the 
sentence.  As you change nouns to verbs, your writing 
becomes less abstract.  Example:  Instead of  ...”We 
made an application”...use...”We applied”.   

• Omit superfluous words.  For example:  Instead of…..”In 
order to”…use... ”to”.  Instead of….”because of the 
fact”....use….”because, since”. 

• Use positive sentences. 
• Replace negative phrases with a single word that means 

the same thing. For example: Instead of...”not 
able”…use…”unable”. 

 



 LEADERSHIP  
& EMPLOYEE 
DEVELOPMENT 

 

Guide to Creating Accessible Documents-2012 Page 9 of 30 

Fonts and Font Sizes 
It is more important to use a standard font and consistent font 
size rather than try and identify which font or font size "is best." 
While some people with or without visual or print disabilities find 
Arial or Veranda fonts are easier to read, others depend on the 
ligatures or little hooks on the letters to decode what letter they 
are looking at and predict what word they are reading. 

The keys for fonts and font sizes are: 

1. Use standard font types/styles.  
2. Be consistent in the font and font size used in your 

documents. 
3. Avoid complicated, decorative or cursive fonts. 
4. Sans serif fonts have been reported to be more legible 

when the character size is small. 

Sans serif fonts are characters that do not have small strokes 
at the ends such in Verdana or Arial.  

Serif fonts have decorative strokes at the end of the characters 
such as in Times New Roman. 

Colour Contrast 
It is important to have good contrast between foreground and 
background colours in your documents. This includes any 
shaded text such as table headers or cells. 

 

Figure 1: Results from the Colour Contrast Analyzer 

The Web Accessibility Tools Consortium has developed a Color 
Contrast Analyzer Text2 for the web. The following illustration 
shows that it will work on Word documents. The colours 
checked were the colours for the foreground and background of 
the headings in this document. This is a free tool! 

Creating Accessible Documents 

It doesn't matter what application or program you use to create 
documents for staff or students, there are some basic principles 
that you can use to ensure that the documents have the 
structural elements necessary for people using adaptive 
technology; for example such as screen readers.  

http://www.wat-c.org/tools/CCA/1.1/
http://www.wat-c.org/tools/CCA/1.1/
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By creating documents to be inherently accessible there is no 
need to create "differently accessible" documents as the 
documents can be readily converted to alternate forms or 
accessed by persons who use adaptive technology.   

Below are some key elements to accessible documents that 
will be the focus in this document: 

• The use of templates for specific documents. 
• The use of heading styles.  
• Creating a custom style, based on an existing one for 

headings. 
• Adding Alt Text for images or links. 
• Using captions for images in print or digital documents. 
• The use of fonts:  San serif fonts, such as, Frutiger, Arial, 

and Verdana are preferable. 
• Use good colour contrast. 
• Consider using plain language. 
• Do not use tables for design layout. 
• Identify table header rows.  
• Do not use Text Boxes in Word documents. 
• Do not use single cell tables to isolate important 

information in a Word document. 
• Create one image out of grouped objects and add Alt 

Text to one image. 
• Where there are complex images, provide a descriptive 

document in addition to the source document or ensure 
that the complex image is explained in the body text. 

 

Word 2007 
When working with Word 2007 it is best to use a template for all 
of your documents.  This will ensure that each document that 
you develop will have the features that you want as well as a 
consistent look and feel.    

Templates 
To create a template in Word: 

1. Open a blank document. 
2. Select the Office Button, Hover your cursor over “Save 

As”, and then select “Word Template”.  
3. Name your template in the “File Name” field.  
4. Press Tab or move to the "Save as Type" field.  
5. Choose "Word Template" from the listing. 
6. Select Save. Make sure that the template is going to be 

saved in the Trusted Templates folder. In most cases it 
will be saved in a Trusted Templates folder automatically. 

7. Add any static content to the document such as logos, 
contact information, disclaimers and so forth.  

8. Change the fonts, add or modify styles. Create the look 
and feel you want for the document. 

9. Re-Save the template and close it.  

To use your template: 

1. Select the Office Button and choose New. 
2. Choose the My templates. 
3. Your new template will be in the list of available 

templates.  
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4. Select the template you would like to use and select OK. 
5. Add any content you would like. 
6. Save the Document.  

Styles 
Styles are formatting instructions, such as “Title” for the title of 
your document, “Heading 1” to indicate a top-level heading, 
“Heading 2” to perhaps indicate a sub-heading and the “Body 
Text” style to indicate the body text.  These features help your 
readers to make sense of your document.   

If a heading style is not used to identify changes in the subject 
matter or topic, every piece of text in your document will have 
the structural element of a paragraph. This means that people 
with disabilities who are using technology to navigate your 
documents to read specific content will not be able to so.  

In addition to these formatting instructions (Styles) making your 
document easy for your readers, it can also save you time in 
formatting and editing your documents.  Styles are used to 
structure your document and it is best to use the built-in styles 
that are provided by Microsoft and modify those rather than 
create your own.  Not all assistive technologies will be able to 
understand styles that have been created on your own. 

If you have created a template then you can easily change the 
default heading styles to look the way you want.  

How to modify the existing heading styles in a template: 

1. Open the template you want to Modify.  
2. Select the Office Button, Choose Open, Select the 

Trusted Templates folder, Select the Template, and 
Click Open. 
 
*Do not use Office Button, New, My templates... as this 
will open a new document based on your template. 
 

3. Select the Arrow in the lower right corner (Figure 2) of 
the Styles Group to open the Style Pane (Figure 3). 
 

 

Figure 2: Styles Group 

 

Figure 3: Styles Pane in Word 
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4. Right Click the mouse on the Style you want to modify 

and choose Modify. 
5. A dialog box opens with the options for formatting the 

style (Figure 4). 

 

Figure 4: Modify Styles dialog box in Word 

6. Make any changes to the colour, font (such as to Arial or 
Verdana) size, or alignment (such as centre aligned). 

7. There are other options related to borders and paragraph 
alignment under the Format button in this dialog box. 

8. Once you've finished modifying the style, choose to either 
apply the changes to this document only or other 
documents based on this template. 

9. Click OK. 

Creating a New Heading Style 
Remember the following tips for creating a new heading style: 

1. Whether you choose to Modify an existing style or to 
Create a new style, a dialog box opens with all of the 
elements that you can modify. 

2. If you are creating a new heading style with a different 
look and feel, it is important to base it on an existing 
heading style to ensure that the structure of headings is 
maintained in the document. 

3. If you don't base the new heading style on an existing 
heading style it will look like a heading but the underlying 
structure will be a normal paragraph. 

4. It is a good idea to include the heading level number in 
the new style name so that you remember what level it is 
when creating other documents based on this template. 

   

Figure 5: Create New Style dialog box in Word 2007 
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Alt Text and Captions for Images 
Pictures and other non-text elements can be inserted into word 
documents.  These graphics should support the content and will 
need to be formatted with alternative text descriptions because 
the visual objects will not be understood by those who use 
screen reading technology. 

Alt Text - is a brief and concise description of what the image is. 
For people with disabilities who are using reading technology to 
access your documents, using Alt Text will give them the 
information you want them to have about an image in your 
document. Without Alt Text someone who is blind would hear 
something like "graphic image452.gif."  

In Microsoft Office for Mac 2004 or 2008 you cannot add Alt text 
to images.  If you are using an Office for Mac version of Word it 
is important to use captions for images.  

To add Alt Text to an Image or Object: 

1. Select the Image or Object. 
2. Right Click.  
3. Select the Size... link. 
4. In the Size dialog box choose the Alt Text tab. 
5. Type or Copy and Paste the Alt Text into the edit area.  
6. Select Close.  

 

Figure 6: Alt Text dialog in Word 

Captions for Images, Tables and Equations 
Captions are useful if the document is being printed and the 
image or object isn't clear on the printed page. Someone 
reading the document will then have access to the description of 
the graphic in the caption. 

To add a caption for images: 

1. Select the Image or Object. 
2. Right Click the mouse.   
3. Choose the Insert Caption.... link. 
4. A Caption dialog box opens with the figure number 

already in place. Type out the caption you would like to 
include. You can also Copy and Paste information into 
the Caption field. 

5. Select OK. 
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Figure 7: Caption dialog box in Word 

To add a caption for table and equations: 

1.  Follow the same instructions. 
2. Remember that the table or equation captions need 

to go before the table so that someone who can't see 
the table would know what type of data they are about 
to encounter. 

Tables 
Ensuring that a uniform table is used for data is essential to a 
well-structured document.  In Word 2007 the Table Gallery will 
also add an accessible table to your document.  Always 
remember that tables should be inserted into a document and 
not drawn and tables should not be used for the design layout. 

To add a table to a Word document: 

1. On the Insert tab, in the Table group, choose 1 of the 2 
ways.  

a. Visually select the number of rows and columns 
from the grid provided in the Insert Table (Figure 
8). 

b. Click the Insert Table (Figure 8)... link, this will 
open the Insert Table dialog box (Figure 9) and 
select the number of rows and columns.  

 

 

Figure 8: Insert Table via Table Gallery 

 

Figure 9: Insert Table dialog box 
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Header Rows Repeat 
A Heading Row should be added to tables to differentiate the 
heading text from the data area of the table.  If your table spans 
more than one page it is also important to have the header rows 
repeat at the top of each page. 

To have table header rows repeat: 

1. Select the First Row or Cell within the table. 
2. Right Click the mouse to open the Context Menu. 
3. Choose the Table Properties... link and then select the 

Row tab at the top of the dialog box. 
4. Check the Check Box to have the Header Rows Repeat 

(Figure 10). 
5. Uncheck the “Allow row to break across pages” check 

box, as this improves the readability of the information in 
your tables. 

6. Close the Table Properties dialog box by either Clicking 
the OK button or Tabbing to the OK button and Pressing 
Enter. 

 

Figure 10: Table Properties 

Text Boxes and Single Cell Tables 
Often when we want to identify important information to 
someone reading content, we use either a single cell table or a 
text box.  Single cell tables are not a good use of tables and 
using them this way is contrary to a well-structured document.  

Text boxes sort of float over the text of the document and if one 
moves the cursor down a page when they encounter a text box 
the cursor remains at the left margin and doesn't move to the 
text box. This means that someone using reading technology 
will never see this important information. 

The most accessible way to identify important information 
visually and accessibly is to use paragraph formatting. 

This paragraph uses a style created by the 
document author called "Important." It has a 
border and is indented left and right from the 
margin. It is completely accessible AND makes 
the text stand out visually for someone reading 
the document on screen or in print. Same visual 
effect but completely accessible. 

To create the paragraph style for important 
information: 

1. Select the Paragraph you want to Format. 
2. Select the Arrow in the lower right corner of the Styles 

group (Figure 11).  
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Figure 11: Styles group in Word 2007 

3. Select the New Style button. 
 
You'll be able to see how the changes you make look in 
your document as you add them  
(Figure 12). 

 

Figure 12: Creating a Paragraph Style using the 
Create New Style dialog box 

 
4. Change the Font, Font Size, and the Alignment if you 

want. 
5. To double indent the paragraph as in the example above, 

Click on the Format button while in the New Style dialog 
box. This opens a drop-down menu. 

6. Choose Paragraph. This opens the Paragraph dialog 
box. 

7. In the area that identifies the Indentation for the 
Paragraph - make the Indentation Equal for Both Left 
and Right. 

8. Close the Paragraph dialog box by clicking the OK button 
or tabbing to the OK button and Pressing Enter. 

9. While in the New Style dialog box Click on the Format 
button or Press Alt + letter O and this time choose 
Border. This opens the Borders and Shading dialog box. 

10. Choose the Border you want and apply it to the 
paragraph. Make sure the border will be applied to the 
Paragraph and not text.  
 

 

Figure 13: Borders and Shading dialog box in Word 
2007 

11. You can change the Padding or Margins between the 
Text and Border if you need a bit more space.  Select the 
Options button in the Borders and Shading dialog box. 
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12. Once you have the Borders and Shading the way you 
want click the OK button or Tab to the OK button and 
press Enter to close it. 

13. You can then decide whether to add this style to the 
template or use it only in the current document.  

 

 

Figure 14: Borders and Shading Options dialog box 

Bulleted and Numbered lists 
If you need more space between bullets or numbers in a list, 
don't use the Enter key to create the space. This method breaks 
the list structure and for someone who is using technology to 
read your document each bulleted or numbered list item will be 
identified as an individual list. 

This means that there is no relationship between the listed items 
even though visually the relationship may be identifiable. 

To add space between bulleted or numbered list items 
select the list and: 

1. Select the Arrow in the lower right corner of the 
Paragraph group.  

 
 

2. Uncheck the Check Box: Don't add space between 
paragraphs of the same style. The default spacing is 10pt 
after each bulleted or numbered list item.  

 

Figure 15: Paragraph dialog box in Word 

3.   Close the paragraph dialog box once the spacing is 
adjusted.  
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Word 2010 
When working with Word 2010 it is best to use a template for all 
of your documents. This will ensure that each document that 
you develop will have the features that you want as well as a 
consistent look and feel.    

Templates 
To create a template in Word: 

1. Open a blank document. 
2. Select File > Save As. 
3. Name your template in the “File Name” field.  
4. Press Tab or move to the "Save as Type" field.  
5. Choose "Word Template" from the listing. 
6. Select Save. Make sure that the template is going to be 

saved in the Trusted Templates folder. In most cases it 
will be saved in a Trusted Templates folder automatically. 

7. Add any static content to the document such as logos, 
contact information, disclaimers and so forth.  

8. Change the fonts, add or modify styles. Create the look 
and feel you want for the document. 

9. Re-Save the template and close it.  

To use your template: 

1. Select File > New. 
2. Select the template file and click Open. 
3. Add any content you would like. 
4. Select File > Save As. 
5. Name your template in the “File Name” field.  

6. Save your document as a Word Document (*.docx). 
 

Styles 
Styles are formatting instructions, such as “Title” for the title of 
your document, “Heading 1” to indicate a top-level heading, 
“Heading 2” to perhaps indicate a sub-heading and the “Body 
Text” style to indicate the body text. These features help your 
readers to make sense of your document.   

If a heading style is not used to identify changes in the subject 
matter or topic, every piece of text in your document will have 
the structural element of a paragraph. This means that people 
with disabilities who are using technology to navigate your 
documents to read specific content will not be able to so.  

In addition to these formatting instructions (Styles) making your 
document easy for your readers, it can also save you time in 
formatting and editing your documents. Styles are used to 
structure your document and it is best to use the built-in styles 
that are provided by Microsoft and modify those rather than 
create your own. Not all assistive technologies will be able to 
understand styles that have been created on your own. 

If you have created a template then you can easily change the 
default heading styles to look the way you want.  
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How to modify the existing heading styles in a template: 

1. Open the template you want to Modify.  
2. Select File > Open. Select the Trusted Templates 

folder, select the Template, and click Open. 
 
*Do not use File > New and select the template as this 
will open a new document based on your template and 
will not allow you to modify the template itself. 
 

3. Styles are located in the Styles group on the Home tab. 
Right click on the style you want to modify and choose 
Modify.  

4. A dialog box opens with the options for formatting the 
style (Figure 1). 

 

Figure 1: Modify Styles dialog box in Word 

5. Make any changes to the colour, font (such as to Arial or 
Verdana) size, or alignment (such as centre aligned). 

6. There are other options related to borders and paragraph 
alignment under the Format button in this dialog box. 

7. Once you've finished modifying the style, choose to either 
apply the changes to this document only or other 
documents based on this template. 

8. Click OK. 

Creating a New Heading Style 
Remember the following tips for creating a new heading style: 

1. Whether you choose to Modify an existing style or to 
Create a new style, a dialog box opens with all of the 
elements that you can modify. 

2. If you are creating a new heading style with a different 
look and feel, it is important to base it on an existing 
heading style to ensure that the structure of headings is 
maintained in the document. 

3. If you don't base the new heading style on an existing 
heading style it will look like a heading but the underlying 
structure will be a normal paragraph. 

4. It is a good idea to include the heading level number in 
the new style name so that you remember what level it is 
when creating other documents based on this template. 

Alt Text and Captions for Images 
Pictures and other non-text elements can be inserted into word 
documents. These graphics should support the content and will 
need to be formatted with alternative text descriptions because 
the visual objects will not be understood by those who use 
screen reading technology. 
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Alt Text - is a brief and concise description of what the image is. 
For people with disabilities who are using reading technology to 
access your documents, using Alt Text will give them the 
information you want them to have about an image in your 
document. Without Alt Text someone who is blind would hear 
something like "graphic image452.gif."  

If you are using an Office for Mac version of Word it is important 
to use captions for images. 

1. Right click on the Image or Object 
2. Select Format Picture (Figure 2). 

 

Figure 2: Selecting Format Picture in Word 2010. 

 

3. Select Alt Text from the pane on the Format Picture 
window. 

4. Enter alt text in the Description field (Figure 3). 

 

Figure 3: Adding alt text in Word 2010 

5. Select Close. 

Captions for Images, Tables and Equations 
Captions are useful if the document is being printed and the 
image or object isn't clear on the printed page. Someone 
reading the document will then have access to the description of 
the graphic in the caption. 

To add a caption for images: 

6. Right click the Image or Object. 
7. Select Insert Caption. 
8. A Caption dialog box opens with the figure number 

already in place. Type out the caption you would like to 
include. You can also Copy and Paste information into 
the Caption field. 
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Figure 4: Adding a caption in Word 2010 

9. Select OK. 

To add a caption for table and equations: 

10. Follow the same instructions. 
11. Remember that the table or equation captions need to go 

before the table so that someone who can't see the table 
would know what type of data they are about to 
encounter. 

 

Tables 
Ensuring that a uniform table is used for data is essential to a 
well-structured document. In Word 2010 the Table Gallery will 
also add an accessible table to your document. Always 
remember that tables should be inserted into a document and 
not drawn and tables should not be used for the design layout. 

To add a table to a Word document: 

1. On the Insert tab, in the Table group, choose 1 of the 2 
ways.   

a. Click the Table icon in the Tables group. Click and 
drag to select the number of rows and columns 
you want in the table (Figure 5).  

 

 

Figure 5: Inserting a table in Word 2010 
(method a) 



 LEADERSHIP  
& EMPLOYEE 
DEVELOPMENT 

 

Guide to Creating Accessible Documents-2012 Page 22 of 30 

b. Click the Table iron in the Tables group. Select 
Insert Table. This will open the Inter Table dialog 
box (Figure 6). Select the number or rows and 
columns you want in the table. 

 

Figure 6: Inserting a table in Word 2010 (method b) 

Header Rows Repeat 
A Heading Row should be added to tables to differentiate the 
heading text from the data area of the table. If your table spans 
more than one page it is also important to have the header rows 
repeat at the top of each page. 

To have table header rows repeat: 

2. Right click on the first row or cell in the table. 
3. Select Table Properties. 
4. Select the Row tab at the top of the dialog box. 

5. Check the Check Box to have the Header Rows Repeat 
(Figure 7). 

 

Figure 7: Having header rows repeat in Word 2010. 

6. Uncheck the “Allow row to break across pages” check 
box, as this improves the readability of the information in 
your tables. 

7. Close the Table Properties dialog box by either Clicking 
the OK button or Tabbing to the OK button and Pressing 
Enter. 

Text Boxes and Single Cell Tables 
Often when we want to identify important information to 
someone reading content, we use either a single cell table or a 
text box. Single cell tables are not a good use of tables and 
using them this way is contrary to a well-structured document.  
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Text boxes sort of float over the text of the document and if one 
moves the cursor down a page when they encounter a text box 
the cursor remains at the left margin and doesn't move to the 
text box. This means that someone using reading technology 
will never see this important information. 

The most accessible way to identify important information 
visually and accessibly is to use paragraph formatting. 

This paragraph uses a style created by the 
document author called "Important." It has a 
border and is indented left and right from 
the margin. It is completely accessible AND 
makes the text stand out visually for 
someone reading the document on screen 
or in print. Same visual effect but 
completely accessible. 

To create the paragraph style for important information:  

1. Select the Paragraph you want to Format. 
2. Click the arrow in the lower right corner of the Styles 

group (Figure 8).  

 

Figure 8: Opening the Styles pane in Word 2010 

3. Select the New Style button (Figure 9). This will open the 
Create New Style from Formatting dialogue box  
(Figure 10).  

 

Figure 9: Creating a new style in Word 2010 

 

Figure 10: Creating a New Style dialogue box in  
Word 2010 
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4. Change the Font, Font Size, and the Alignment if you 
want. 

5. To double indent the paragraph as in the example above, 
click the Format button while in the New Style dialog 
box. This opens a drop-down menu. 

6. Choose Paragraph. This opens the Paragraph dialog 
box. 

7. In the area that identifies the Indentation for the 
Paragraph, make the indentation Equal for both Left and 
Right. 

8. Close the Paragraph dialog box by clicking OK or 
tabbing to the OK button and pressing Enter. 

9. While in the New Style dialog box click on the Format 
button or Press Alt + letter O and choose Border. This 
opens the Borders and Shading dialog box. 

10. Choose the Border you want and apply it to the 
paragraph. Make sure the border will be applied to the 
Paragraph and not Text.  

11. You can change the padding or margins between the text 
and border if you need a bit more space. Select the 
Options button in the Borders and Shading dialog box. 

12. Once you have the borders and shading the way you 
want click the OK button or Tab to the OK button and 
press Enter to close it. 

13. You can then decide whether to add this style to the 
template or use it only in the current document.  

Bulleted and Numbered lists 
If you need more space between bullets or numbers in a list, 
don't use the Enter key to create the space. This method breaks 
the list structure and for someone who is using technology to 
read your document each bulleted or numbered list item will be 
identified as an individual list. 

This means that there is no relationship between the listed items 
even though visually the relationship may be identifiable. 

To add space between bulleted or numbered list items 
select the list and: 

1. Select the Arrow in the lower right corner of the 
Paragraph group (Figure 11).  

 

Figure 11: Adding space between list items in Word 2010 

2. Uncheck the Don't add space between paragraphs of 
the same style check box. The default spacing is 10pt 
after each bulleted or numbered list item.  

3. Click OK. 
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Outlook 
Microsoft Outlook 2010 is a personal information manager that 
includes email, a calendar, a task manager, a contact manager, 
note taking capabilities, a journal, and a web browser. Most 
commonly, Outlook is used to send and receive email. It is 
important for emails written in Outlook be AODA compatible and 
easy to read.  

To modify the default type settings of your email: 

1. Select File > Options. 
2. Select Mail from the left pane on the Outlook Options 

window (Figure 12) and click the Stationery and Fonts 
button. 

 
Figure 12: Modifying default type settings in Outlook 
2010 

3. Click the Font button for New mail messages. This 
action will open the Font dialogue box (Figure 13). 

 

Figure 13: Setting font attributes in Outlook 2010 

4. Set the Font to Arial or Verdana and set the font Size to 
at least 12 and click OK. 

5. Repeat steps 3 and 4 to adjust the font for Replying or 
forwarding messages. 

6. Click OK to close the Outlook Options window. 
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PowerPoint 
Power point presentations are visual tools to depict information.  
It is important to remember that as the design layout and 
content in the presentation become more complex with the 
addition of graphics, animation, tables and charts – the less 
accessible the presentation will be.   

Some key elements to consider are: 

• Create a text-only version of your PowerPoint.  This will 
make it easier for persons using adaptive technology 
such as screen readers. 

• Ensure your presentation has a high colour contrast 
between the foreground and background.   

• Use the largest possible font size, a minimum of 16 
points. 

• Avoid backgrounds. 
• Avoid Grouped Objects as they are inherently 

inaccessible. 
• If using audio and video content, please note that only 

captioned videos can be used in course content. 
Seneca’s Libraries handles captioning of our streaming 
videos through the digital library systems and new media 
services. Videos that are offered on a vendor platform 
(FilmsOnDemand, NBC Learn, NFB) are handled by the 
vendor / distributor. For our in-house made library videos, 
the Library creates caption files manually through either 
Camtasia or a text editor, using our scripts as a content 

base.For details on captioning, please contact Seneca 
Libraries. 

• Minimize the use of images and objects. 
• Must provide Alt Text on all images and objects. 

To provide Alt Text for images and objects on a PowerPoint 
slide: 

1. Select the Image or Object. 
2. Right Click the mouse.  
3. Select the Size... link. 
4. In the Size dialog box choose the Alt Text tab (Figure 1). 

 

Figure 1: Size dialogue box in PowerPoint 

 
5. Type or Copy and Paste the Alt Text into the edit area.  
6. Select Close.  
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PDF Document Accessibility 
Adobe has produced a comprehensive guide for creating 
accessible Adobe files3. This guide has talked about tagged 
PDF through all of the topics. What do we mean by this and how 
do you do it? 

The ability to "Tag" a PDF document provides the accessibility 
to the document content. A Tag is much like the information you 
would see in the Reveal Codes of WordPerfect or the code used 
to write HTML or web documents.  For each piece of content in 
your document there should be a corresponding Tag in the PDF 
document.  

If you've built the structure and accessibility into your documents 
as illustrated in this guide, the Tags in a PDF document 
converted from your source document should provide a "logical 
reading order" for someone using adaptive technology. 

There are several programs that can create PDF files, but very 
few of them produce tagged PDF files.  If you are using 
Microsoft Word or PowerPoint, you can often create accessible, 
tagged PDF files, keeping in mind that the accessibility of the 
PDF will depend on the accessibility of the original document.   

If you have followed the steps in this document when creating 
your Word document or PowerPoint presentation, then the 
accessibility and conversion settings are essentially the same.  
You can follow the instructions below for Word to convert the 
PowerPoint files to PDF as well. 

You can create accessible PDF files in Office, as long as the 
following requirements are met: 

1) The file is accessible. This includes providing alternative 
text for images. 

Course Packs 
The goal is to make accessible course pack material available to 
students with disabilities at the same time it is available to 
students without disabilities. 

The solution to providing course packs in accessible formats is 
to have the course pack available in a CD containing the course 
pack content in tagged PDF format.  If you've followed the 
guidelines in this document when creating your Word 
documents, the structure will be carried through to the tagged 
PDF version of your work.  

You can create a tagged PDF from Word, PowerPoint or Adobe 
InDesign. The key is to add the document structure as you 
create the course pack material. 

If your course pack is compiled using articles from the library’s 
electronic databases, you must ensure that the digital versions 
of the articles are available so that they can be converted to an 
accessible format.   

As a Professor once you have permission to compile a course 
pack you will need: 
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• To contact Michael Cripps, Grenville Management & 
Printing at the Newnham campus (ext. 22558, room 
B1091) who will complete all copyright registrations and 
assist you with the production details 

• To place a course pack adoption with the bookstore, 
follow the same steps as you would in doing a textbook 
adoption.  You can access this information at 
https://www2.senecacollege.ca/estore/fbr/index.jsp 

 

Copyright Compliance & Course packs  
Seneca Libraries has produced a library guide on course packs 
and copyright compliance. Visit 
http://Seneca.libguides.com/content.php?pid=83762&sid=31076
48 

Resources 
The following resources are organized by application. The first 
set of resources is generic and includes best practices tips and 
techniques. 

General Document Accessibility 
These resources contain common elements of accessible 
documents that can be applied to any document created. 

Adobe Accessibility Resource Centre4. 

Best Practices for Creating Accessible Microsoft Word 
Documents from CalPoly5. 

Creating Accessible Documents from Accessible IT @ NC 
State6 . 

Creating Accessible Documents from Empire State College New 
York7. 

WebAIM Microsoft Word article on creating accessible 
documents8. 

Accessible Course Packs 
These resources are a combination of course pack and general 
accessibility tips for instructors for students with disabilities. 

Accessible Instructional Material by Poly9. This is a tagged PDF 
document so it is accessible but it does not have links or 
headings so is difficult to navigate if you are using adaptive 
technology. 

Word 2003 
These resources are for Word 2003 but you can learn 
techniques for Word 2007 or 2010 from them. 

Creating Accessible Word 2003 Documents from CalPoly10.  

This is a tagged PDF document so you can see what a well 
tagged and structured PDF looks like while finding out how to 
create accessible Word documents. 

Creating Accessible Word 2003 Documents from California 
State University ENACT11. 

https://www2.senecacollege.ca/estore/fbr/index.jsp
http://seneca.libguides.com/content.php?pid=83762&sid=3107648
http://seneca.libguides.com/content.php?pid=83762&sid=3107648
http://www.adobe.com/accessibility/
http://accessibility.calpoly.edu/instmaterials/document_creation/best_practices.html
http://accessibility.calpoly.edu/instmaterials/document_creation/best_practices.html
http://www.ncsu.edu/it/access/tutorials/
http://www.ncsu.edu/it/access/tutorials/
http://www.esc.edu/esconline/across_esc/disabsvc.nsf/3cc42a422514347a8525671d0049f395/5dc1b1858e034c97852571bd006df3ca?OpenDocument
http://www.esc.edu/esconline/across_esc/disabsvc.nsf/3cc42a422514347a8525671d0049f395/5dc1b1858e034c97852571bd006df3ca?OpenDocument
http://www.webaim.org/techniques/word/
http://www.webaim.org/techniques/word/
http://access.sdsu.edu/pdf/InstructionalChecklist.pdf
http://accessibility.calpoly.edu/instmaterials/document_creation/Creating_Accessible_Microsoft_Word_2003_Document.pdf
http://www.csub.edu/ati/documents/Accessible_MS_Word_documents.doc
http://www.csub.edu/ati/documents/Accessible_MS_Word_documents.doc
http://www.esc.edu/disability-services/community-resources/creating-accessible-documents/
http://www.esc.edu/disability-services/community-resources/creating-accessible-documents/
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Word 2007 
These resources are specific to word 2007 but you can use the 
techniques in other versions of Word. 

Making Documents Accessible from Humbolt University12. A 
note about the video on using Word styles: a person using a 
screen reader will only know that you've used intense emphasis 
if they have a verbosity setting chosen to announce style 
changes and they are reading the document word by word. If 
someone is reading through the document or reading paragraph 
by paragraph, sentence by sentence or line by line changes in 
style are not identified. For those of us using screen readers 
having every style change announced is annoying and 
distracting from comprehension. That aside, this is a good visual 
resource and is captioned. 

Making Word 2007 Documents Accessible from the University of 
Bradford13. This is a tagged PDF document so you can see how 
a well structured and tagged PDF documents works. 

Microsoft Word 2007: Creating Accessible Documents from14 . 

Logical Document Structure Handbook: Word 200715, ISBN 0-
9738370-9-8 by Karen McCall, M.Ed. 

Creating Microsoft Word to PDF Documents from Adobe16. This 
is a tagged PDF quick reference card. 

 

Word 2010 
Making Word 2010 Documents Accessible from the University of 
Bradford17 

Authoring Digital Office Document (ADOD) Project from OCAD 
University18 

http://x.dc-uoit.ca/accessibledocs/
http://www.bradford.ac.uk/lss/documentation/making-word2007-documents-accessible/making-word2007-documents-accessible.pdf
http://www.bradford.ac.uk/lss/documentation/making-word2007-documents-accessible/making-word2007-documents-accessible.pdf
http://teachingcommons.cdl.edu/access/docs_multi/documents/2007WordCSUv2_Final.pdf
http://www.karlencommunications.com/products.htm
http://blogs.adobe.com/accessibility/assets/WordToPDFReferenceCard_v1.pdf
http://www.brad.ac.uk/lss/documentation/making-word2010-documents-accessible/making-word2010-documents-accessible.pdf
http://www.brad.ac.uk/lss/documentation/making-word2010-documents-accessible/making-word2010-documents-accessible.pdf
http://adod.idrc.ocad.ca/
http://adod.idrc.ocad.ca/
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Web Addresses for Cited References 
                                            

1 Accessibility for Ontarians with Disabilities Act provincial home 
page: 
http://www.mcss.gov.on.ca/en/mcss/programs/accessibility/  
2 Web Accessibility Tools Consortium Color Contrast Analyzer: 
http://www.wat-c.org/tools/CCA/1.1/  
3 Creating Accessible Adobe PDF Files: 
http://www.adobe.com/enterprise/accessibility/pdfs/acro6_pg_ue
.pdf 
4 Adobe Accessibility Resource Centre: 
http://www.adobe.com/accessibility/  
5 Best Practices for Creating Accessible Word Documents from 
CalPoly: 
http://accessibility.calpoly.edu/instmaterials/document_creation/
best_practices.html  
6 Creating Accessible Documents from Access IT @ NC State: 
http://www.ncsu.edu/it/access/tutorials/  
7 Creating Accessible Documents from Empire State College 
New York: http://www.esc.edu/disability-services/community-
resources/creating-accessible-documents/  
8 WebAIM Microsoft Word article on creating accessible 
documents: http://www.webaim.org/techniques/word/  
9 Accessible Instructional Material from CalPoly: 
http://access.sdsu.edu/pdf/InstructionalChecklist.pdf  
10 Creating Accessible Word 2003 Documents from CalPoly: 
http://accessibility.calpoly.edu/instmaterials/document_creation/
Creating_Accessible_Microsoft_Word_2003_Document.pdf  
 
 

                                                                                                       

 
11 Creating Accessible Word 2003 Documents from California 
State University ENACT: 
http://www.csub.edu/ati/documents/Accessible_MS_Word_docu
ments.doc  
12 Making Documents Accessible from Humbolt University: 
http://x.dc-uoit.ca/accessibledocs/  
13 Making Word 2007 documents Accessible from the University 
of Bradford: 
http://www.bradford.ac.uk/lss/documentation/making-word2007-
documents-accessible/making-word2007-documents-
accessible.pdf  
14 Microsoft Word 2007: Creating Accessible Documents from 
California State University: 
http://teachingcommons.cdl.edu/access/docs_multi/documents/
2007WordCSUv2_Final.pdf  
15 Logical Document Structure Handbook: Word 2007 by Karen 
McCall: http://www.karlencommunications.com/products.htm  
16 Creating Microsoft Word to PDF Documents quick reference 
card from Adobe: 
http://blogs.adobe.com/accessibility/assets/WordToPDFReferen
ceCard_v1.pdf  
17 Making Word 2010 documents accessible from the University 
of Bradford: http://www.brad.ac.uk/lss/documentation/making-
word2010-documents-accessible/making-word2010-documents-
accessible.pdf 
18 Authoring Digital Office Document (ADOD) Project from 
OCAD University: http://adod.idrc.ocad.ca/ 

http://www.mcss.gov.on.ca/en/mcss/programs/accessibility/
http://www.wat-c.org/tools/CCA/1.1/
http://www.adobe.com/enterprise/accessibility/pdfs/acro6_pg_ue.pdf
http://www.adobe.com/enterprise/accessibility/pdfs/acro6_pg_ue.pdf
http://www.adobe.com/accessibility/
http://accessibility.calpoly.edu/instmaterials/document_creation/best_practices.html
http://accessibility.calpoly.edu/instmaterials/document_creation/best_practices.html
http://www.ncsu.edu/it/access/tutorials/
http://www.esc.edu/disability-services/community-resources/creating-accessible-documents/
http://www.esc.edu/disability-services/community-resources/creating-accessible-documents/
http://www.webaim.org/techniques/word/
http://access.sdsu.edu/pdf/InstructionalChecklist.pdf
http://accessibility.calpoly.edu/instmaterials/document_creation/Creating_Accessible_Microsoft_Word_2003_Document.pdf
http://accessibility.calpoly.edu/instmaterials/document_creation/Creating_Accessible_Microsoft_Word_2003_Document.pdf
http://www.csub.edu/ati/documents/Accessible_MS_Word_documents.doc
http://www.csub.edu/ati/documents/Accessible_MS_Word_documents.doc
http://x.dc-uoit.ca/accessibledocs/
http://www.bradford.ac.uk/lss/documentation/making-word2007-documents-accessible/making-word2007-documents-accessible.pdf
http://www.bradford.ac.uk/lss/documentation/making-word2007-documents-accessible/making-word2007-documents-accessible.pdf
http://www.bradford.ac.uk/lss/documentation/making-word2007-documents-accessible/making-word2007-documents-accessible.pdf
http://teachingcommons.cdl.edu/access/docs_multi/documents/2007WordCSUv2_Final.pdf
http://teachingcommons.cdl.edu/access/docs_multi/documents/2007WordCSUv2_Final.pdf
http://www.karlencommunications.com/products.htm
http://blogs.adobe.com/accessibility/assets/WordToPDFReferenceCard_v1.pdf
http://blogs.adobe.com/accessibility/assets/WordToPDFReferenceCard_v1.pdf
http://www.brad.ac.uk/lss/documentation/making-word2010-documents-accessible/making-word2010-documents-accessible.pdf
http://www.brad.ac.uk/lss/documentation/making-word2010-documents-accessible/making-word2010-documents-accessible.pdf
http://www.brad.ac.uk/lss/documentation/making-word2010-documents-accessible/making-word2010-documents-accessible.pdf
http://adod.idrc.ocad.ca/
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